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1 Application / intended use 

• Relative turbidity measurement of liquid media for mid to high turbidity range 
(200…300.000 NTU equivalent) 

• For use in hygienic applications of the food, beverage and pharmaceutical industries 

• Suitable for CIP/ SIP up to 140 °C for a maximum of 120 minutes 

• Not suitable for use in explosive atmospheres 

• Not suitable for safety-related unit parts (SIL) 

2 Conformity with standards 

The basic safety and health requirements are met through fulfillment of: 

• 2014/30/EU Electromagnetic Compatibility 

• 1935/2004/EU Consumer Goods Ordinance 

• EN 61000-6-2:2005 (Interference Immunity) 

• EN 61000-6-4:2007 + A1:2011 (Interference Emissions) 

3 Safety instructions 

These safety instructions must be followed to  

• Avoid endangering persons and the environment. 

• Avoid damage to the sensors. 

• Prevent faulty batches during production. 
 
The electrical connections may only be performed by persons with the necessary technical skills 
(e.g. certified electricians or persons with technical training in electrics) and by persons with the 
necessary authorization from the operator. 

The power supply and the control circuit inputs and outputs must be professionally wired. The 
current state-of-the-art of electrical connections must be adhered to. See also section 8 "Wiring 
diagram". 

 

The following details must be noted in particular: 

• Safety instructions 

• Electrical connection data 

1. All persons involved with the setup, commissioning, operation, service and maintenance 
of the sensor must be suitably qualified. 

2. This operating manual must be followed closely. The operator must ensure that the per-
sonnel has read and fully understood the operating manual. 

3. All work must be performed with utmost care and may only be executed by authorized and 
trained personnel. The applicable national regulations regarding opening and repairing of 
devices must be complied with. 

4. We recommend storing the operating manual near the measuring device in an easily ac-
cessible location. 

5. The sensor must be de-energized prior to alterations and maintenance.  

6. The working area of the operator must offer enough space to minimize the risk of injury. 

7. The technical data specified in the operating manual and on the type plate must be noted. 
 
Warranty coverage shall not be granted for any damage that can be attributed to improper execu-
tion of work on the device.  
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4 Special features / advantages 

• The sensor structure is based on a modular device platform which can be tailored to re-

quirements and is easy to exchange if faulty 

• Front flush sensor for easy cleanability 

• Optics made of high resistance sapphire 

• Independent to reflexions at small diameters or electro-polished surfaces 

• Color independent measurement at 860 nm wave length 

• Hygienic design with Negele weld-in sleeve 

• Individual setting/programming via PC or User Interface 

• Two configurable LEDs on the display unit 

5 Options / Accessoires 

• User Interface with small or large display (retrofittable) 

• Programming adapter MPI-200 (PC-based) 

• Tool for detaching the signal module 

• Full featured remote version (see order matrix for ITM-51R) 

• Pre-assembled PVC cables 

6 Installation and Connection 

6.1  Mounting position 

 

Mechanical connection / installation notes 

• The sensor must be installed in that way that the sensor tip is entirely washed 

around by media and no bubbles can occur. It therefore is advisable to install the 

device in rising pipes. Refer to the drawings below for reference. 
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6.2 Hygienic installation requirements 

 

 

 

Dimensions for hygienic installation with Tri-Clamp 

  

Tri-Clamp: T < D Tri-Clamp extended: T < (D-d). 

Recommended mounting positions 

 

 

 

ITM-51 in vertical pipe ITM-51 in horizontal pipe 

 

Conditions for hygienic installation according 3A and EHEDG 

• The ITM-51 / ITM-51R is designed for CIP/SIP cleaning. The sensor can withstand a 

maximum of 140 °C / 120 min. 

• The mounting position must guarantee self-draining properties. 

• If mounted with a Tri-Clamp connection the mounting tee, mounting position and 

gasket need to follow the actual 3A or EHEDG standards and guidelines. 
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Not permitted mounting positions using Tri-Clamp 

  

Installation from above or below should be avoided with Tri-Clamp. This can lead to 

incorrect measurements due to air accumulation or deposits. 

 

6.3 Configuration 

The ITM-51 relative turbidity meter is set to operate without requiring special adapta-

tions. In isolated instances, some parameters may need to be adjusted. The parameteri-

zation may be changed using the PC-based MPI-200 programming adapter, IO-Link or the 

User Interface directly on the sensor. This can be performed either directly on location or 

in the office in a dry simulation. 

 

The sensor is delivered with the following default settings: 

Analog Output 1 (X45 on terminal connection 4 and 5): 
 turbidity 1 with measurement range 0…100 %TU 

Relay Output (X67 on terminal connection 6 and 7): switching output with 10 %TU set point 

An external control voltage (24 V DC) can be used to switch between measuring range 1 and 2 
at digital input X3. The digital input X3 is short-circuit proof. 

 

The parameter list accompanying the sensor contains the sensor settings for analog output 1 (ter-
minals 4 and 5) under X45a and for relay output (terminals 6 and 7) under X67. 

The ITM-51 relative turbidity meter features a modular design with a “tree structure”, which can 
be tailored to meet requirements and can be easily exchanged in the event of a fault.  

This tree structure is used by the MPI-200 programming adapter software for the PC and the User 
Interface in the sensor. The software is subdivided into Display, Electronics (signal interface) and 
Sensor (turbidity measurement). 
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When setting the parameters, please note that a hierarchy of authorization levels exists ( 0 Mon-
itoring, 1 Adjustment (QuickSetup), 2 Setup 3 Calibration): 

 

Sensor (turbidity measurement):  
The analog output of the sensor for turbidity can be freely configured. 

Turbidity: Two different turbidity ranges can be set here, independent of each other. The upper 
range limit can be freely selected. Switching between the both ranges can be done with the A53/I53 
signal module while using the digital switching input X3. This function is not available with the 
A42/I42 and A52/I52 signal modules. 

Switching output (only applicable for A52/I52 and A53/I53 electronics): A setpoint for turbidity as 
well as the working direction of the switching output can be selected.  

Electronics (Signaling interface): 

• Signal selection for the 4…20 mA signal: Selection between Turbidity 1 or 2 and the applica-
ble turbidity category 

• Set value for 4 or 20 mA signal: By default, the lower range limit is used for the 4 mA signal 
and the upper range limit for the 20 mA signal. This can be adjusted as necessary. 

• "No Media" warning signal: Current loop signal when the sensor is not immersed in a medium 
→ dry running. 

• "Outside Spec." warning signal: Current loop signal if an operating state is outside of the spec-
ified range. The measurement accuracy can no longer be guaranteed. 

• "Global Failure" error signal: Current loop signal if a malfunction occurs, for example if the 
device fails. 

• Signal limit for underrange and overrange: Lower or upper limit of the current loop signal 
that is still valid and linear when output below 4 mA or above 20 mA. 

• "Underflow/overflow" error signal: Current loop signal is below or above the underrange or 
overrange limit. 

• Signaling Simulation: Simulates the current loop signal, where the source value is briefly re-
placed by the entered parameter value. 

• LED configuration: These two LEDs can be configured as required. The procedure is described 
in section 6.2.2. 

A list of the parameters set in the turbidity sensor is included with the delivery. These parameter 
values, as well as those changed by the users themselves, can be printed out using the MPI-200 
programming adapter via File → Parameter Data → Print and can also be exported as a file to the 
PC (via File → Parameter Data → Export Data File (*.xml)). 

When making the settings, note the help texts in the MPI software for each parameter. They 
provide useful information on changing the selected parameter. 

6.4 Settings using the MPI-200 programming adapter 

The MPI-200 programming adapter is connected to the ITM-51 turbidity meter via the external MPI-
200-F adapter piece. It must be ensured that the ITM-51 turbidity meter is permanently connected 
to the supply voltage while the parameters are being set. 
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After the sensor is connected to the PC and the user software is opened, the following window ap-
pears: 

 
 

1. Information on the current process value 
2. Buttons for changing the parameter setting 
3. Information on the current source value 
4. Adjustable PC parameters 
5. Adjustable sensor parameters 

 
Clicking on the + in the menu opens a submenu 
in which parameters can be adjusted.  
 

 
Note:  
For further settings, please see also the description in the MPI-200 product information. 

To set or change parameters directly in the sensor (see section 6.2 "Settings using the User Inter-

face"), you need the ID codes contained in the table below. This table only lists the most important 

ID codes.  

 

 

5. 

Connection plug for the MPI-200-F 

adapter as an intermediate plug be-

tween the ITM-51 electronics and the 

MPI-200 connection 3 (see the next fig-

ure). 

3 

1: no function 

2: USB port for connecting to a PC 

3: Connection cable to adapter for sensor 

Connection of the MPI-200 programming adapter 

1 

2 3 

1. 

2. 

3. 

4. 



Operating Manual ITM-51/ITM-51R 9 

Further ID codes can be found in the user software. To view these, right-click on "Info" by the pa-

rameter name. An info box appears with the respective ID (see graphic below): 

 

 

Because the search number must have 6 digits, an additional digit is always added in front of the 

five-digit ID (30034 in the graphic above). This digit depends on the node as follows: 

4 for changes to the display 

3 for changes to the signal interface 

0 for changes to the turbidity measurement 

Because the signal selection is located in the single interface node, the ID code for the "Signal 

selection" example above is: 330034. 

A list of all ID codes can be printed out via the PC user interface. To do so, click on File → Parameter 

Data → Print to open the corresponding window and print out the complete list of ID codes. 

 

 

List of important ID codes: 

Parameter/Parameter Name Access/Setup Mode 
Search Number  

(ID Number) 
Value Name 

Sensor    

Unit Turb1 Setup 014021 Turbidity1 

Damping 1 Setup 014027 Turbidity1 

Range Tb.1 Setup 014029 Turbidity1 

Unit Turb2 Setup 014022 Turbidity2 

Damping 2 Setup 014028 Turbidity2 

Range Tb.2 Setup 014030 Turbidity2 

X-Pnt 01 Setup 013151 Tu.%Solids 

Y-Pnt 01 Setup 013171 Tu.%Solids 
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Thru Setup Thru Tu.%Solids 

X-Pnt 08 Setup 013158 Tu.%Solids 

Y-Pnt 08 Setup 013178 Tu.%Solids 

Current Loop Signal 1    

Signal Selection Setup 330031 X45a I-Out 

Underrange Limit Setup 330141 X45a I-Out 

Overrange Limit Setup 330211 X45a I-Out 

no Media= Setup 330121 X45a I-Out 

Out Spec.= Setup 330221 X45a I-Out 

Underflow= Setup 330151 X45a I-Out 

Overflow= Setup 330161 X45a I-Out 

Failure= Setup 330131 X45a I-Out 

Simulation Setup 330201 X45a I-Out 

Digital Input    

Direction Setup 330821 Digital-In 

Simul. Inp Setup 330831 Digital-In 

Current Loop Signal 2    

Signal Selection Setup 330032 X45b I-Out 

Underrange Limit Setup 330142 X45b I-Out 

Overrange Limit Setup 330212 X45b I-Out 

no Media= Setup 330122 X45b I-Out 

Out Spec.= Setup 330222 X45b I-Out 

Underflow= Setup 330152 X45b I-Out 

Overflow= Setup 330162 X45b I-Out 

Failure= Setup 330132 X45b I-Out 

Simulation Setup 330202 X45b I-Out 
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Digital Output    

Signal Selection Setup 330037 X67 D-Out 

Function Setup 331114 X67 D-Out 

Direction Setup 331124 X67 D-Out 

Inp.  Method Setup 331114 X67 D-Out 

Switch Pt. Setup 331144 X67 D-Out 

Hysteresis Setup 331254 X67 D-Out 

ON Delay Setup 331174 X67 D-Out 

OFF Delay Setup 331114 X67 D-Out 

No Media= Setup 331194 X67 D-Out 

Out Spec.= Setup 331204 X67 D-Out 

Underflow= Setup 331214 X67 D-Out 

Overflow= Setup 331224 X67 D-Out 

Failure= Setup 331234 X67 D-Out 

Simulation Setup 331244 X67 D-Out 

Display    

Language Setup 451010 Set Display 

Contrast Setup 451020 Set Display 

Scrs delay Setup 451050 Set Display 

Password Setup 450103 Set Display 

6.5 Settings using the User Interface 
 

The software structure of the User Interface is similar to PC software version. 
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The system is operated using two control buttons to the left and right of the display.  These two 
buttons can be used to navigate through the tree structure of the User Interface to change param-
eters. The button functions are as follows:  

 

Notes on setting using an ID number 

 

1) Press and hold the right button, the display jumps to the menu. 

2) Confirm right key 2x briefly to position "ID search". 

3) Press and hold the right key and select the desired item "ID Search 

4) Press and hold the right key, then enter the ID number from right to left. 

 Proceed as follows: 

a) Select the desired position (navigation with right/left - press the left key): Change position 

to the left, press right key, change position to the right.)  

b) Press and hold the right-hand key at the desired position until the field is highlighted in 

grey, then enter the numerical value with the right/left keys and confirm with the right-

hand key for a long time until the number is no longer stored. Then enter the next digit. 

c) When all digits have been entered, press the left or right key until all digits are highlighted 

in gray. 

d) Next, press and hold the right key. The system then jumps to the selected parameter and 

this can now be entered / changed in the same way. Start here - again, press and hold the 

right button. 

e) For some system-relevant parameters, a confirmation prompt will appear asking whether 

the change should be saved or not. 

5) The input can be aborted by pressing and holding the left button. The setup can be canceled by 

pressing and holding the left button several times. 

 

• Pressing the right button means that the parameter is changed or saved. 

• Pressing the left button means leaving the setting without changing it. 

6.5.1 Screen display 

After the sensor parameters have been adapted/changed, or after the sensor is switched on and 

no change is made, the sensor switches to the display mode after a certain period. In the display 

mode, the main measurement value is shown as described in the picture below. If a second output 

option is available (only for electronic versions A52, A53) the actual value is shown in the bottom 

line of the display. 

 

Button Press briefly Press and hold

R Jump to next node, parameter Edit a node, parameter

L Jump back to previous node, parameter Leave editing mode without saving, return to next higher level 

R/L Scroll up and down

R and L 

together

Press both buttons for 10 seconds: the menu jumps back to 

the beginning (attention: this is not a reset)

R right

L left
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To leave the display mode and create settings on the sensor, press the right button next to the 

display twice to enter the menu. The sensor then displays the start page, from where the settings 

can be created. 

6.5.2 LED configuration 

The display unit features 2 LEDs that can be individually configured. The LED to the left of the 

display is LED 1 while the one to the right is LED 2.  

The following options can be selected when setting the LEDs: 

• Signal Selection: The following signals can be selected: turbidity 1 and 2. 

• Output function, direction of action, switch point entry method, switch point, hysteresis  

• Switch ON Delay, Switch OFF Delay: The digital output is switched on or off with the delay 

set here. Values can be set between 0...30 s. 

• Warn-S: no Media, Warn-S: Outside Spec., Err-Sig: Underflow, Err-Sig: Overflow, Err-Sig: 

Global Failure: The effect of each parameter on the LED display can be set. The following 

can be selected: "No Effect on Output", Output Fast Blinking" (0.4 s interval), "Output Slowly 

Blinking" (1 s interval), "Output ON" (LED on continuously) and "Output OFF". "Output" refers 

to the LED here. 

• Signaling Simulation: The source value is briefly replaced by the entered parameter value. 

The following situations can be simulated: "Output OFF", "Output ON", "Output Slowly Blink-

ing" and "Output flashes rapidly". "Output" refers to the LED here. 

The turbidity sensor is delivered with the following factory settings for the LEDs:  

• LED 1 (left LED) 
If the sensor is in a normal state, this LED is off. 
Err-Sig: Overflow: The LED flashes every second if the sensor registers an overrange error. If 
the sensor is in a normal state, this LED is off. 
Err-Sig: Temperature Error: The LED is permanent on if the sensor registers a medium 
temperature above 130°C permanent.  
All other errors are indicated while the LED flashes in short intervals. 
 

• LED 2 (right LED)  
Condition of the switching output: LED lights up continuously if the presetted turbidity 
range is attained. The working direction of the switching output and therefore the behavior 
of the LED can be changed. 

6.6 Examples of sensor settings 

Several examples of settings that can be created on the User Interface or on the user interface of 

the PC follow. 

 

Value name Measured value cur-
rently being output 
at the current output 

Measurement unit 

The bottom line is used to display the second output if 

available. 



Operating Manual ITM-51/ITM-51R 14 

6.6.1 Menu structure User Interface 

 

 

Calibr. Calibr. Calibr. Calibr.

Display

Calibr.

Us1-Slope

Us2-Slope

X45a 4mA

X45a 20mA

X45b 4mA

Menu

QuickSetup

Setup

ID Search

Calibration

Us1-Offset

Us2-Offset

X45b 20mA

X67 4mA

X67 20mA

X67 D-Out

X45a I-Out

Digital-In

X45b I-Out

Turbidity1

Turbidity2

Tu. %Solids

Setup

Sensor

Display

Contrast

Menu Menu

ID Search

QuickSetup

Menu

Range Tb.2

Language

LED2 D-Out

Set Displ.

LED1 D-Out

Sensor

Quick Setup Setup ITM51

Unit Turb2 Display

Range Tb.1 000000

Setup Setup Setup Setup

Menu

QuickSetup QuickSetup QuickSetup

ID-Search

ID Search ID Search ID Search

Unit Turb1 Sensor

R

R la. R la.

R

R la.

R R

R la.

R la.

R

R la.
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6.6.2 Example for setting turbidity 1 range without an ID code:  

 

Alternative to entering the measurement range as described above, the measurement range can 

also be adjusted by entering an ID code.  

To do so, go to “YES” on the ID search page and enter the ID code using the buttons. After the code 

is confirmed, the sensor display shows the menu in which the parameter can be adjusted. 

  

Calibr.

100.00

200.00

200.00

200.00

Save Data?

 

No / Yes

Menu

100.00

ITM51

Turbidity1

x.xx %TU

Turbidity 1

Range Tb.1

last step

for all

digits

Repeat the

ID: 014030

x.xx %TU

ID: 014030

Range Tb.1

Turbidity 1

x.xx %TU

ID: 014030

Range Tb.1

ID: 014030

Turbidity 1

x.xx %TU

Turbidity 1

 

Range Tb.1

Turbidity 1

x.xx %TU

ID: 014030

Range Tb.1

x.xx %TU

ID: 014030

Unit Turb1

Unit Turb2

Turbidity 1

Quick Setup

Unit Turb1

Unit Turb2

Range Tb.1

Quick Setup

Range Tb.1

Range Tb.1

Turbidity 1

x.xx %TU

QuickSetup

Setup

ID Search

x.xx %TU

ID: 014030

100.00 %TU

100.00

Range Tb.1

R la.

R 

R la.

R

R la.

R/L

R la.

R la.

R

R la.

R la.

R la.

Using the left and right 

buttons, navigate to the 

parameter to be adjusted 

and set the required value. 



Operating Manual ITM-51/ITM-51R 16 

6.6.3 Setting of customer-specific turbidity / %solids curve via PC software 

After the PC software is started, a customer-specific curve for the turbidity can be entered via the 

following node: Turbidity Measurement → % solids → (+). Values need to be entered for at least 

2 X and Y points. Up to 8 support points for X and the associated Y values can be entered to estab-

lish the relationship between turbidity (X) and % solids (Y). The Y values together with the associ-

ated X values form coordinates that act as support points for the linearization curve. If 0 is entered 

for any of these points, that support point is deactivated. 

X-Point 01...X-Point 08 (Turbidity): This parameter is used to define the customer-specific meas-

urement range of the turbidity. Values can be entered from 0…300 kNTU. 

Y-Point 01...Y-Point 08 (% solids): This parameter is used to define the customer-specific meas-

urement range. Values can be entered from 0...100%. 
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7 Installation of the “Large User Interface” (LUI) 

1. Remove the plastic cover (continue with step 4), or remove the puck with the mounted small 
display (continue with step 2) 

2. Remove the small display 
3. Install the puck in the sensor head 
4. Mount the large display 

Hot-plug function: The large display can be installed while the sensor is energized, but this re-

quires the usual precautionary measures when working with electronic components.  

If the display is being installed while energized, it is necessary to press both buttons simultane-

ously for > 10 s after the display is installed to activate the display. 

7.1 Retrofitting the display if a display was not yet installed 

 

 

 

After removing the plastic cover, the large display can be inserted in the head of the sensor. The 

tabs (Fig. 2) must be inserted in the appropriate openings on the puck (Fig. 1). Then the display can 

be easily pressed onto the puck. No wiring is required. 

Note: After the Large User Interface is mounted, the sensor can only be operated on this display 

since the display conceals the connector for the MPI-200 adapter. If operating the sensor using the 

programming software is preferred, the display must be removed. Then the connector of the pro-

gramming adapter can be plugged in. 

  

 

   

Fig. 1 Fig. 2 Fig. 3 

 

 

Attention: The connector of the programming adapter (Fig. 3) must be connected in the correct 

direction → the green spacer must face the cable exit (M12 connector or PG). 

Remove the plastic cover: To do so, bend the tabs 

slightly inwards with a screwdriver to be able to 

remove the cover easily. 
 



Operating Manual ITM-51/ITM-51R 18 

7.2 Retrofitting the display if a small display (SUI) was already installed 

First the puck with the mounted display needs to be removed using the puck puller tool (Fig. 1). To do so, 

detach the wires from the cable terminal. Then insert the five arms of the puck puller in the plastic tabs 

of the puck (Fig. 2). 

Push the puck puller all the way into the sensor head and push 

the disk as far as possible toward the sensor head so that the 

arms of the puck puller firmly grasp the puck.  

Pull the puck with the display out of the sensor housing and 

finally pull off the small display from the puck.  

 

Now the puck without the display can be properly positioned and installed back in the sensor head 

and the wiring can be reconnected to the cable terminal. Then the large display can be mounted → 

see "Retrofitting the display if a display was not yet installed". 

7.3 Operating the large display 

The large display (LUI) is operated in the same way as the small display (SUI). It is operated using two 

operating buttons below the display: 

 

After the sensor is started, the screen saver appears in which the process values of the sensor are 

displayed one after the other. To reach the start page from here, press one of the two buttons briefly.  

  

Fig. 4 Fig. 5 
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8 Dimensions 

ITM-51 with vertical head orientation. 

          Process Connection               

  SOL     TCx      TLx                Vxx      

 

 

TriClamp size   Varivent size   

Type Ø A (mm / inch)  Type Ø A (mm / inch) Ø B (mm / inch) 

TC1 / TL1 50,5 / 1.99  V25 66.0 / 2.60 53.0 / 2.09 

TC2 / TL2 64,0 / 2.52  V40 84.0 / 3.31 71.0 / 2.79 

T25 / TL5 77,5 / 3.05     

TC3 / TL3 91,0 / 3.58     

 
 



Operating Manual ITM-51/ITM-51R 20 

 
ITM-51 with horizontal head orientation. 

Process connection   
 
        SOL      TCx       TLx     Vxx 
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9 Electrical connection cable gland 

Connection of cables to terminal strip: required if the puck is removed from the sensor. 

Electrical connection with cable gland 

 

10 Electrical Connection Digital Signal Modules 

10.1 Terminal Block of I5x Series 

 
 

X I52 / A52 I53 / A53 

X1 Power Supply + 

X2 Power Supply - 

X3 
IO-Link / not      

affected 
IO-Link /  

Digital Input X3 

X4 Analog Output X45 + 

X5 Analog Output X45 - 

X6 Relay Output 67 

X7 Relay Output 67 

 
 
 
 

10.2  Terminal Block of I4x Series 

 

X I42 

X1 Power Supply + 

X2 Power Supply - 

X3 IO-Link 

X4 Analog Output X45 + 

X5 Analog Output X45 - 
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10.3  M12 connector cables color 

 

M12 Connector Pin Standard Color Anderson Color 

 

1 Brown Red 

2 White Black 

3 Blue Green 

4 Black Not assigned 

5 Grey White 

 
 



Operating Manual ITM-51/ITM-51R 23 

10.4  Overview electrical connections 
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11 ITM-51 IO-Link Device Identity 

 
 
 

12 ITM-51 IO-Link Process Data 
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12.1 ITM-51 IO-Link Process data description 

 

Name Description Data 

type 

Bit 

length 

Bit 

Offset 

Value range Gra-

dient 

Off-

set 

Unit 

Turbidity 

1 

Value of    

turbidity  1 

Float 

32 

32 0 0.01 - 300.00 kNTU 

0.75 - 75.00 kEBC 

0.66 - 197.00 %TU 

0.33-100.00 %Soli 

1 0 kNTU  

kEBC 

%TU, 

%Solids 

Turbidity 

2 

Value of    

turbidity 2 

Float 

32 

32 32 0.01 - 300.00 kNTU 

0.75 - 75.00 kEBC 

0.66 - 197.00 %TU 

0.33-100.00 %Soli 

1 0 kNTU  

kEBC 

%TU, 

%Solids 

% Solids % solids 

based on 

turbidity 

value 

Float 

32 

32 64 0 - 100 % 1 0 % 

Turbidity 

Base 

Value of    

turbidity 

base 

Float 

32 

32 96 0.01 - 300.00 kNTU 1 0 kNTU 

Process value Turbidity 1 (Bits 0-31) 

 

 

Process value Turbidity  2 (Bits 32-63) 

 

 

 Process value % Solids (Bits 64-95) 

 

 

 Process value Turbidity Base (Bits 96-127) 

 
On PLC-Input side use data type Float32 as data type for each process value. 
 
 

0

32

31

1

64

96

95

63

127

1
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12.2 IO-Link Eventlist 

Measurement Events 

Event 

Code 

Event 

Type  

Event Name (EN) Event Name (DE) 

36285 Warning Outside specification: Turbid-

ity 1. Currently the sen-

sor is not able to perform a reli-

able measurement 

Außerhalb der Spezifikation: Trü-

bung 1. Derzeit ist der Sen-

sor nicht in der Lage, eine zuver-

lässige Messung durchzuführen 

36286 Warning Underrange: Turbidity 1 Untersteuerungsgrenze: Trübung 1 

36287 Warning Overrange: Turbidity 1 Übersteuerungsgrenze: Trübung 1 

36288 Error Underflow: Turbidity 1 Unterlauf: Trübung 1 

36289 Error Overflow: Turbidity 1 Überlauf: Trübung 1 

36290 Warning No Media: Turbidity 1. Cur-

rently the sensor cannot de-

tect any medium 

Kein Medium: Trübung 1. Der Sen-

sor kann derzeit kein Medium er-

kennen 

36291 Error Fail: Turbidity 1 Fehler: Trübung 1 

36292 Warning Outside specification: Turbid-

ity 2. Currently the sen-

sor is not able to perform a reli-

able measurement 

Außerhalb der Spezifikation: Trü-

bung 2. Derzeit ist der Sen-

sor nicht in der Lage, eine zuver-

lässige Messung durchzuführen 

36293 Warning Underrange: Turbidity 2 Untersteuerungsgrenze: Trübung 2 

36294 Warning Overrange: Turbidity 2 Übersteuerungsgrenze: Trübung 2 

36295 Error Underflow: Turbidity 2 Unterlauf: Trübung 2 

36296 Error Overflow: Turbidity 2 Überlauf: Trübung 2 

36297 Warning No Media: Turbidity 2. Cur-

rently the sensor cannot de-

tect any medium 

Kein Medium: Trübung 2. Der Sen-

sor kann derzeit kein Medium er-

kennen 

36298 Error Fail: Turbidity 2 Fehler: Trübung 2 

36299 Warning Outside specification: Per-

cent Solids. Currently the sen-

sor is not able to perform a reli-

able measurement 

Außerhalb der Spezifikation: Pro-

zent-Feststoffgehalt. Der-

zeit ist der Sen-

sor nicht in der Lage, eine zuver-

lässige Messung durchzuführen 
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36300 Warning Underrange: Percent Solids Untersteuerungsgrenze: Prozent-

Feststoffgehalt 

36301 Warnung Overrange:  Percent Solids Übersteuerungsgrenze: Prozent-

Feststoffgehalt 

36302 Error Underflow:  Percent Solids Unterlauf: Prozent-Feststoffgehalt 

36303 Error Overflow:  Percent Solids Überlauf: Prozent-Feststoffgehalt 

36304 Warning No Media:  Percent Solids. Cur-

rently the sensor cannot de-

tect any medium 

Kein Medium: Prozent-Feststoffge-

halt. Der Sensor kann der-

zeit kein Medium erkennen 

36305 Error Fail:  Percent Solids Fehler: Prozent-Feststoffgehalt 

36306 Warning Outside specification: Turbid-

ity Base. Currently the sen-

sor is not able to perform a reli-

able measurement 

Außerhalb der Spezifikation: Trü-

bung Basis. Derzeit ist der Sen-

sor nicht in der Lage, eine zuver-

lässige Messung durchzuführen 

36307 Warning Underrange: Turbidity Base Untersteuerungsgrenze: Trü-

bung Basis 

36308 Warning Overrange: Turbidity Base Übersteuerungsgrenze: Trü-

bung Basis 

36309 Error Underflow: Turbidity Base Unterlauf:Trübung Basis 

36310 Error Overflow: Turbidity Base Überlauf: Trübung Basis 

36311 Warning No Media: Turbidity Base. Cur-

rently the sensor cannot de-

tect any medium 

Kein Medium: Trübung Ba-

sis. Der Sensor kann der-

zeit kein Medium erkennen 

36312 Error Fail: Turbidity Base Fehler: Trübung Basis 

36341 Error No Sensor Connected Kein Sensor angeschlossen 

36342 Error General Error. The sensor indi-

cates a general error 

Gerätefehler. Der Sensor mel-

det einen allgemeinen Fehler 

36343 Error Clipping Error Übersteuerungsfehler 

36344 Error LED defect LED defekt 

36345 Error Receiver defect Empfänger defekt 
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36346 Error Reference Error Referenzfehler 

36347 Error Leakage Error Leckage Fehler 

36348 Error Temperature Error Temperaturfehler 

36349 Error Bootloader active Bootloader aktiv 

 

 

13 Repair and maintenance 

The turbidity sensor described here is maintenance-free. However, it is recommended to check 

the calibration of the turbidity sensor once a year. For this check the ITM-51-CU calibration 

check tool is recommended.  

 

 

 

 

 

 

                 Ceramic reference 

 

      ITM-51-CU-cap           ITM-51-CU-bottom     ITM-51-V40 placed in ITM-51 

CU 

              

The ITM-51-CU unit is used as below: 
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1. Cleaning the lens. The lens must be free of residues and scratches. 
2. Changing the measurement category to NTU 
3. Setting the upper range limit to 300 kNTU 
4. Placing the ceramic reference plate in the bottom piece according to the ITM-51 process 

connection. Fitting types TLx and Sox are placed from bottom and centered automatically. 
Fitting type TCx and Vxx are placed on top as shown in the drawing above. The centering is 
done while screwing the cap on to the bottom piece. 

5. Checking the displayed NTU value and compare with the reference value printed on the la-

bel of ITM-51-CU. The value needs to be within the range of ±6% as printed on the label as 

well. 
6. If the displayed value is outside the limits it is recommended to send back the ITM-51 for 

recalibration. 
 

14 Technical data 

Measurement cate-

gory 

The measurement cate-

gory can be selected  

%TU, NTU, EBC, %solids (customized) 

Measurement range The measurement range 

is freely adjustable 

0…300.000 NTU equivalent 

0…200 %TU 

0…75.000 EBC 

Process connection  CLEANadapt G1/2" hygienic 

Tri-Clamp 1.5", 2", 2.5", 3" 

Varivent DN 25 (type F) 

DN 40/50 (type N) 

Process pressure  -1…50 bar  / -14…750 psi 

Tightening torque  20 Nm (CLEANadapt system) 

Materials Connecting head 

Sensor 

Lens 

Plastic cover/sight glass 

Stainless steel 1.4308 (CF-8) 

Stainless steel 1.4404 (316L) 

Sapphire 

Polycarbonate 

Temperature ranges Ambient 

Process 

CIP/SIP 

-10…60°C / 14...140 °F 

-10…130°C / 14...266 °F 

Up to 140°C / 284 °F max. 120 min 

Reproducibility of turbidity < 1% of upper range limit 

Resolution/measure-

ment range 

the resolution is depend-

ent on the selected meas-

urement range 

range/ NTU resolution/ NTU  

< 1 000 15 

1 000…10000 30 

10000…100000 100 
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Accuracy 200…9.999 NTU 

 

10.000…300.000 NTU 

±3 % from measurement value;  

±50 NTU offset 

±5 % from measurement value 

Long-term stability ±0,2 %  from measurement value  

Response time  for turbidity measure-

ment 

0,75 s 

Measurement principle infrared backscatter wave length 860 nm 

Electrical connection Cable gland 

Cable connection 

Supply voltage 

Protection class 

2 x M16 x 1.5 

2 x M12 connector 1.4305 

18…36 V DC max. 190 mA 

IP 69K 

Output Analog 

 

 

 

Digital 

1x analog output 4...20 mA, potential-

free, 1x relay output potential-free 

1x digital input (24 V DC), short-circuit 

proof 

IO-Link v1.1 

Weight  750 g 

 
 
 

 

 

 

 

 

 

 


